
1

Setting Up QuickBooks®

Lesson 2
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Lesson Objectives

• To discuss decisions that must be made 
before using QuickBooks

• To create a new QuickBooks company using 
the EasyStep Interview

• To set QuickBooks preferences in the 
Interview

• To record the opening balance for a checking 
account

• To enter customers, jobs, vendors, 
accounts, and items
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Creating a QuickBooks Company

• EasyStep Interview walks you through setting up your business:

• Company Information

• Your industry

• Your company organization

• Sales information

• Sales tax information

• Estimates

• Sales orders

• Sales receipts

• Preferences

• Business start date

• Creating an account and entering an opening balance

• Reviewing the chart of accounts based on your industry 

• Completing company file setup
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Starting the EasyStep Interview

To begin adding a new company:

1. Start QuickBooks.

2. Select Create a new company, click the
Start your new company file now button, or 
choose New Company from the File menu. 
QuickBooks displays the EasyStep 
Interview window.
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Entering Company Info

To create a new QuickBooks company file:

1. At the Welcome window for the interview, 
click Start Interview to begin.

2. In the Company Name field, type Lockhart 
Design and press Tab.

3. Press Tab again and type 94-1234567 as 
the Tax ID number. 
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Entering Company Info

To create a new QuickBooks company file:

4. Type the following information in the address, city, state, 
and ZIP fields:

1239 Bayshore Road

Middlefield, CA 94432

5. Now enter the following information in the Phone # and Fax 
# fields:

Phone #: 650-555-1234

Fax #:650-555-5678

6. Next enter the email and Web addresses for Lockhart 
Design.

Email: margaret@samplename.com

Website: www.lockhart_design.com

7. Click Next.
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Entering Company Info

To create a new QuickBooks company file:
8. In the “Select your industry” window, scroll 

down the list until you find Retail Shop or 
Online Commerce and select it. 

9. Click Next.

10.In the “How is your company organized?” 
window, select Sole Proprietorship.

11.Click Next.

12.In the “Select the first month of your fiscal 
year” window, make sure January is 
selected.

13.Click Next.
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Entering Company Info

To create a new QuickBooks company file:
14.In the “Set up administrator password” 

window, click Next. 

15.Click Next to save the company file.

16.In the “Filename for New Company” 
window, make sure that QuickBooks is set to 
save the file in the QBTrain folder you set up 
during the introduction to the guide.

17.Click Save to accept the default filename of 
“Lockhart Design.”
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Indicating what you sell

To indicate what you sell:

1. Click Next to display the “What do you sell?” 
window.

2. Select Both services and products.

3. Click Next.
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Entering sales information

To indicate how you enter sales:
1. In the “How will you enter your sales in 

QuickBooks?” window, click Record each 
sale individually.

2. Click Next.
3. In the “Do you sell products online?” 

window, make sure the I don’t sell online 
and I am not interested in doing so option
is selected.
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Entering sales tax information

To set up QuickBooks to track sales tax:

1. Click Next to move to the “Do you charge 
sales tax?” window.

2. Click Yes for the question, “Do you charge 
sales tax?” Then click Next.
QuickBooks automatically creates a current 
liability account, called Sales Tax Payable, 
that keeps track of the sales tax you collect 
in your business.
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Creating estimates

To create estimates for your business:
1. In the “Do you want to create estimates in 

QuickBooks?” window, click Yes.

2. Click Next.
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Using sales orders and sales receipts

To set up sales orders and receipts:

1. Click Yes, if the “Tracking customer orders 
in QuickBooks” window displays, then click 
Next.

This screen appears if you are using 
QuickBooks Premier Edition or higher.

2. In the “Using sales receipts in QuickBooks” 
window, click No.

3. Click Next.
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Choose remaining preferences

For this item: Select:

Billing statements No

Progress invoicing Yes

Bill tracking Yes

Do you print checks? I print checks

Inventory No

Credit and debit cards I accept credit cards and 
debit cards

Track time Yes

Employees No

Track multiple currencies No



15

Choosing a start date

The start date is the date for which you 
give QuickBooks a financial snapshot of 
your company assets and liabilities.

To choose a start date:

1. In the “Using Accounts in QuickBooks” 
window, click Next.

2. In the “Select a date to start tracking your 
finances” window, select Use today’s date 
or the first day of the quarter or month.

3. In the date field, type 12/31/2009 and 
then click Next.
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Entering opening balances

To enter the checking account opening 
balance:

1. On the “Add your bank account” window, 
make sure Yes is selected and then click 
Next.

2. Type Checking as the name of the account 
and click Next.

3. For “When did you open this bank 
account?,” click Before.

4. Click Next.



17

Entering opening balances

To enter the checking account opening 
balance:

5. For Statement Ending Date, type 
12/28/2009.

6. In the Statement Ending Balance field, type 
8359.00.

7. Click Next.

8. When QuickBooks asks if you want to add 
another bank account, click No. Then click 
Next.
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Reviewing the chart of accounts

To review the chart of accounts:
1. In the “Review income and expense 

accounts” window, scroll through the 
recommended accounts to get an idea of 
what is included.

You can remove or add accounts from this 
list. Clear the checkmark to remove an 
account; click in the checkmark column to 
add an account.

2. Click Next.
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Finishing the Interview

3. To leave the EasyStep Interview and save your 
changes, click Finish.

4. If the QuickBooks Learning Center appears, click 
Go to QuickBooks.

5. If the QuickBooks Coach appears, click Start 
Working.

After you have completed the EasyStep 
Interview, Intuit recommends that you not use 
the Interview to make changes to your company 
file. 

Use the information in the help options described 
later to help you make changes and adjustments 
to your company file.

Next, you’ll complete the company file setup.
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Completing company file setup

After you have created your company file 
using the EasyStep Interview, you can begin 
using QuickBooks to run your business. 
However, there are some additional tasks you 
might need to do to make sure the company 
file is properly set up and that the data is 
complete.

QuickBooks is based on four key concepts:

• Customers & jobs

• Vendors

• Accounts

• Items
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Adding customers

In order to bill customers with QuickBooks, you 
need to add your customers.

To add a customer:
1. Click Customer Center in the icon bar.
2. Click the New Customer & Job menu button, 

and then choose New Customer.
3. In the Customer Name field, enter the name 

of the customer as you'd like it to appear on 
your Customers & Jobs list. For this exercise, 
type Smith, Lee, and then press Tab.
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Adding customers

5. Press Tab in the Opening Balance field to 
leave this field blank.
For now, leave this field blank. Lockhart 
Design is planning to set up one or more 
jobs for this customer. QuickBooks will 
calculate and track the overall balance for 
this customer from the balances you enter 
for the individual jobs.

6. In Address Info tab, click in the First Name 
field and type Lee.

7. Press tab and type M. as the middle initial 
and in the Last Name field, type Smith.
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Adding customers

8. Press Tab to go to the Address field, and then 
press Enter after Lee M. Smith.

9. Type 43 Hampshire Blvd and press Enter.

10.Type East Bayshore, CA 94327.

11.Click Copy to copy the address to the Ship To 
field. Click OK in the Add to Ship To Address 
Information window.

12.Click OK to add this customer.

The Customer Center appears, with the 
Customers & Jobs list along the left side.

The Customers & Jobs list is the same list as 
the Customer:Job list. It is called Customers & 
Jobs on the Customer Center, and it is called 
Customer:Job on forms. 
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Adding a job

You do not need to add jobs to the Customers 
& Jobs list if your company never does more 
than one job or project per customer. Jobs in 
QuickBooks are optional. If you often perform 
multiple jobs for the same customer, you can 
use jobs in QuickBooks to track the activity 
for each job separately.

Lockhart Design wants to track jobs for Lee 
Smith.
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Adding a job

To add a job for a customer:
1. In the Customers & Jobs list, right-click 

Smith, Lee and choose Add Job.
2. In the Job Name field, type Patio, and 

press Tab.
3. In the Opening Balance field, type 862 and 

press Tab.
4. Enter 12/31/2009 in the As Of field to 

indicate that this was the balance 
outstanding for this job as of the 
QuickBooks start date.
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Adding a job

5. Click the Job Info tab and choose In 
Progress from the Job Status drop-down 
list.
Job status information is for your records—
it gives you a way to keep track of each 
job. 

6. For the Start Date, type 12/15/09 and 
press Tab.

7. In the Projected End date, type 3/15/10
and press Tab.

8. Click OK.
9. If you see a message about a past or 

future transaction, click Yes.
The job now appears under Smith, Lee in 
the Customers & Jobs list.

10.Close the Customer Center.
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Adding vendors

To add a vendor:
1. Click Vendor Center in the icon bar.
2. Click New Vendor in the button bar.
3. In the Vendor Name field, enter the name 

of the vendor as you'd like it to appear on 
your Vendor list. For this exercise, type 
Fay, Maureen Lynn, CPA, and then press 
Tab.

4. In the Opening Balance field, type 350, 
which is the amount you owed this vendor 
as of the start date. Press Tab.

In order to pay your bills with QuickBooks, you 
need to add your vendors. Nearly everyone you 
pay, other than employees, are vendors.
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Adding vendors

5. In the As Of field, enter 12/31/09.

6. In Address Info tab, click in the First Name field and 
type Maureen.

7. Press tab and type L. as the middle initial and in the 
Last Name field, type Fay.

8. Press Tab to go to the Address field, and then press 
Enter after Maureen L. Fay.

9. Type 200 Royal Rd. and press Enter.

10.Type Bayshore, CA 94326.

11.Click in the “Print on Checks As” field, and type 
Maureen Fay.

12.Click OK to add this vendor.

13.If you see a message about a past or future 
transaction, click Yes.

14.Close the Vendor Center.
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Setting up additional accounts

During the EasyStep Interview, you added 
one checking account for Lockhart Design. 

There are two basic types of accounts: 
balance sheet accounts, such as savings or 
checking, and accounts used to group 
transactions for reporting purposes, such as 
income and expense accounts.

Income and expense accounts track the 
sources of your income and the purpose of 
each expense. When you record transactions, 
you usually assign the amount of the 
transaction to one or more income or expense 
accounts.
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Setting up additional accounts

In the EasyStep Interview, you selected 
“Retail Shop or Online Commerce” as the 
industry for Lockhart Design. QuickBooks 
created a chart of accounts based on the retail 
industry. However, Margaret Lockhart also 
receives income from design consulting. She 
needs to modify the chart of accounts to add 
an income account for consulting.



31

Setting up additional accounts

A complete list of your business’ accounts 
and their balances appear in the chart of 
accounts. You use a chart of accounts to 
track how much money your company has, 
how much money it owes, how much money 
is coming in, and how much is going out.

For Lockhart Design, you’ll add an income 
account for her consulting income.
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Setting up additional accounts

To add an income account:
1. From the Lists menu, choose Chart of 

Accounts.
2. Click the Account menu button and choose 

New.
3. In the Add New Account window, choose 

Income and then click Continue.
4. Click in the Account Name field, and type 

Consulting.
5. From the Tax Line Mapping drop-down list, 

choose Sch C: Other business income.
6. Click Save & Close, and then close the 

chart of accounts.
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Adding items

• In QuickBooks, an item is anything that your 
company buys, sells, or resells in the course of 
business, such as products, shipping and handling 
charges, discounts, and sales tax (if applicable). 
You can think of an item as something that shows 
up as a line on an invoice or other sales or 
purchase form.

• QuickBooks provides several different types of 
items. Some—such as the service item or the 
inventory part item—help you record the services 
and products your business sells. Others—such as 
the subtotal item or discount item—are used to 
perform calculations on the amounts in a sale.

• For Lockhart Design, you’ll set up a service item for 
billing the time used for initial consultation for a 
design project. You’ll assign it to the new 
Consulting income account.
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Adding items

To add an item:

1. From the Lists menu, choose Item List.

2. Click the Item menu button, and choose 
New.

3. In the New Item window, choose Service
from the Type drop-down list.

4. Click in the Item Name/Number field and 
type Initial Design Consultation.

5. In the Description field, type Initial design 
consulting.
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Adding items

6. Click in the Rate field, and type 40.

7. In the Tax Code field, choose Non-Taxable 
Sales from the drop-down list.

8. In the Account field, choose Add New.

9. In the new Account screen, enter 
Consulting as the income account, then 
click Save and Close.

10.Click OK to add the new item to the Item 
List.

11.Close the Item List.
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Entering historical transactions

1. All sales (sales receipts, invoices, or 
statement charges)

2. Customer payments received for 
outstanding invoices after the start date

3. Bills received since the start date
4. Bills paid since the start date
5. Deposits made to any of the accounts since 

the start date
6. Any other checks written (other than bills) 

since the start date

If your QuickBooks start date is before today’s 
date, you need to enter past transactions so 
that you have complete financial records from 
the start date forward. It is important to enter 
historical transactions in this order:
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Closing the company file

To close the company file:

1. From the File menu, choose Close Company.
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LESSON 2 Review questions 
and activities
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R e v i e w  q u e s t i o n s  a n d  a c t i v i t i e s
Lesson 2: Setting up QuickBooks

Review questions
1 During the EasyStep Interview, QuickBooks creates income and expense accounts 

based on your company’s _______________________ .

2 When setting up a company file in QuickBooks, what does the Start Date signify?

a The date the business was created

b The first date of the company’s fiscal year

c The date the company purchased QuickBooks

d The date from which you will be entering transactions in QuickBooks

3 When setting up a company file in QuickBooks at the beginning of a fiscal period, 
you would normally select which of the following as the start date?

a The first day of the current fiscal period

b The last day of the previous fiscal period

4 True or false: Once you have set up the chart of accounts, you cannot add, delete, or 
modify accounts.

a True

b False

5 Before working in QuickBooks, you need to enter an ______________ ____________ 
for each account.

6 True or false: Choosing a company organization associates a tax form with your 
business in the QuickBooks file.

a True

b False

7 In QuickBooks, linking income and expense accounts with tax lines does which of 
the following?

a Helps keep your company profitable

b Helps in preparing income taxes

c Helps keep track of sales taxes you owe

d Both B and C

Review activities
1 Turn on class tracking in the company file you created in this lesson.
Copyright 2009 Intuit Inc. QuickBooks in the Classroom
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1 During the EasyStep Interview, QuickBooks creates income and expense accounts 

based on your company’s industry.

2 When setting up a company file in QuickBooks, what does the Start Date signify?

a The date the business was created

b The first date of the company’s fiscal year

c The date the company purchased QuickBooks

d The date from which you will be entering transactions in QuickBooks

3 When setting up a company file in QuickBooks at the beginning of a fiscal period, 
you would normally select which of the following as the start date?

a The first day of the current fiscal period

b The last day of the previous fiscal period

4 True or false: Once you have set up the chart of accounts, you cannot add, delete, or 
modify accounts.

a True

b False

5 Before working in QuickBooks, you need to enter an opening balance for each 
account.

6 True or false: Choosing a company organization associates a tax form with your 
business in the QuickBooks file.

a True

b False

7 In QuickBooks, linking income and expense accounts with tax lines does which of 
the following?
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b Helps in preparing income taxes

c Helps keep track of sales taxes you owe

d Both B and C
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